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INTRODUCCIÓN

1 INTRODUCCIÓN
Esta Nota de Aplicación presenta las principales características e informaciones necesarias para la
configuración y utilización del PLC500MC junto al servoconvertidor SCA06.

Para el control de movimiento es esencial la correcta configuración de la red y de los dispositivos implicados.
Por favor, siga las etapas descritas en este documento para una configuración apropiada.

Para más informaciones al respecto del hardware del producto, interfaces y protocolos de comunicación,
consulte el Manual del Usuario del PLC500, disponible en http://www.weg.net.

1.1 ABREVIACIONES Y DEFINICIONES
CNC: Comando Numérico Computadorizado, es un método que controla los movimientos de máquinas por la
interpretación directa de instrucciones codificadas en la forma de números y letras.

Codesys: Plataforma de programación que permite desarrollar, configurar y monitorear soluciones para
automatización industrial e integración de sistemas.

CoE: CANopen sobre EtherCAT (CANopen over EtherCAT).

EDS: Archivo de configuración que contiene informaciones sobre los objetos, servicios y configuraciones de un
esclavo de red.

EEPROM: Memoria Solamente de Lectura Programable Borrable Electrónicamente (Electrically-Erasable
Programmable Read-Only Memory)

Ethernet: Arquitectura de interconexión para redes locales (IEEE 802.3).

EtherCAT: Tecnología para comunicación de tiempo real basada en Ethernet (Ethernet for Control Automation
Technology).

FB: Bloque de función.

MC: Controlador de movimiento.

PDO: Datos de proceso.

PLC: Controlador lógico programable.

PLCopen: Organización que promueve el control industrial con base en la norma IEC61131-3.

POU: Unidad de organización del programa (Program Organization Unit).

SCA06: Servoconvertidor WEG - SCA06.

SoftMotion: Control suave de movimiento.

SDO: Datos de servicio.

u: Unidad de aplicación.

XML: Archivo de configuración que contiene informaciones sobre los objetos, servicios y configuraciones de
un esclavo EtherCAT.

PLC500MC | 1-1



INTRODUCCIÓN

1.2 SOBRE EL PLC500MC

El PLC500 Motion Controller (PLC500MC) es un Controlador Lógico Programable, con funcionalidades
SoftMotion, que posibilita el control de hasta 32 ejes reales o virtuales, viabilizando una extensa variedad de
controles de movimiento, como el posicionamiento de ejes simples, la sincronización de múltiples ejes (levas
electrónicas y engranajes electrónicas), interpolación de múltiples ejes (lineal, circular y helicoidal), control
de velocidad, control de torque, lectura e interpretación de Código-G, control de máquinas CNC, control para
máquinas de corte y robots industriales, entre otras funcionalidades.

Es desarrollado para atender aplicaciones de medio y de gran porte. Tiene alta velocidad de procesamiento
debido a su CPU compuesta por un procesador Dual-core ARM Cortex-A7, rodando a 1 GHz, un coprocesador
Real-time ARM Cortex-M4 de 200 MHz, memoria RAM de 1 GByte y Flash de 4 GBytes.

Tiene un total de 8 salidas digitales, siendo 3 de estas con funcionalidad PWM hasta 300 kHz, y 8 entradas
digitales, de las cuales 4 pueden operar hasta 150 kHz.

Como interfaces de comunicación cuenta con dos puertos Ethernets independientes, puerto CAN, serial RS485,
USB OTG, USB device y Micro SD Card.

Son utilizados supercondensadores internos para el Reloj de Tiempo Real (RTC) así como para guardar datos
retentivos en la memoria Flash, durante el Power Off, dispensando así el uso de baterías.

El PLC500MC permite la conexión de tarjetas de expansión de entradas y salidas digitales, analógicas,
termopar, PT100, PT1000, célula de carga, relés, etc., dando más flexibilidad a las aplicaciones. Tiene
conectores plug-in y su fijación puede ser hecha en riel DIN 35 o directamente en el tablero.

La programación del PLC500MC es realizada por el software CODESYS, ampliamente difundido en el medio
industrial, posibilitando la utilización de una infinidad de aplicaciones y funciones ya desarrolladas en el
mercado, así como la importación de aplicaciones de otros productos.

Nº Informaciones
1 Conector Ethernet 1
2 Conector Ethernet 2
3 Conector CAN
4 Tarjeta de Memoria
5 USB1 Host
6 USB2 Device
7 Conector Salidas Digitales
8 Cierre de las Expansiones
9 Conector Entradas Digitales
10 Conector Serial RS485
11 LEDs de Indicación
12 Tornillo de Puesta a Tierra
13 Alimentación del Producto (24 V)

Figura 1.1: PLC500 Motion Controller.

El PLC500MC tiene una gran área de memoria disponible para el usuario. El uso de la memoria de una
aplicación puede ser visualizado a través del codesys en: View->View memory usage.

1-2 | PLC500MC



INTRODUCCIÓN

La memoria del PLC500MC está divida conforme la tabla de abajo.

Memoria Capacidad Descripción
Area 0 (HECHA) 128M Bytes Almacena todos los datos locales y globales (variables, bloques de función, instancias, etc.).
Área 1 (CODE) 32M Bytes Almacena todo el código generado por la aplicación, así como los datos constantes.
Área 2 (RETAIN) 64k Bytes Almacena las variables del tipo retain (mantiene el valor luego del reboot del controlador).

Área 3 (PERSISTENT) 16k Bytes Almacena las variables del tipo persistent (mantiene el valor luego del reboot, así como luego del
download, si el layout de éstas se mantiene idéntico).

Tabla 1.1: Áreas de memoria.

1.3 TECNOLOGÍA ETHERCAT

EtherCAT (Ethernet for Control Automation Technology) es una poderosa tecnología para comunicación de
tiempo real basada en Ethernet. con sus tiempos de ciclo cortos, bajos valores de jitter y diferentes topologías
de red, el sistema es usado como estándar en muchas aplicaciones de automatización industrial actualmente.

1.3.1 Interfaces EtherCAT PLC500MC
El PLC500MC tiene dos interfaces independientes (ETH1 y ETH2) que pueden ser utilizadas para la
comunicación EtherCAT. La Figura 1.2 muestra el PLC500MC y sus dos interfaces posibles para la
comunicación EtherCAT.

Figura 1.2: Interfaces EtherCAT

1.3.2 Cobertura EtherCAT

Las funcionalidades soportadas por el protocolo EtherCAT disponible en el PLC500MC incluyen:

Diferentes topologías de Link DC (línea y estrella).

Gran flexibilidad con conexión caliente.

Clocks distribuidos.

Diagnóstico de Link DC: por el editor y por la aplicación.

Barredura de red: reconocer e ingresar esclavos conectados.

Redundancia EtherCAT.

Camadas de protocolos soportados:

PLC500MC | 1-3
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– CoE (CANopen over EtherCAT) / Comunicación SDO.
– EoE (Ethernet over EtherCAT).
– SoE (Servodrive over EtherCAT).
– FoE (File over EtherCAT).
– VoE (Vendor over EtherCAT).

Soporte para esclavos MDP (Modular Device Profile).

Diversos bloques de función para uso en la aplicación.

Para las configuraciones de la red, el PLC500MC tiene una interfaz que facilita las configuraciones del maestro
de la red EtherCAT y sus esclavos. A través de esta interfaz es posible:

Configurar la red de forma automática o utilizar el modo especialista.

Agregar y configurar esclavos utilizando archivos XML EtherCAT (ESI).

Configurar unidades de sincronización. (Sync Unit)

Configurar PDOs (datos de proceso).

Configurar parámetros de inicialización para CoE y SoE.

Configurar esclavos EoE.

Visualizar objetos CoE de forma online y soporte para upload de SDOinfo.

Visualizar histórico de diagnóstico de la red de forma online.

Leer y escribir en la memoria EEPROM de los dispositivos.

1.4 CONTROL DE MOVIMIENTO

El PLC500MC posibilita el control de movimiento para ejes únicos y múltiples ejes sincronizados (levas
electrónicos y engranajes electrónicos) además de posibilitar el control de máquinas CNC y robots industriales.

Los servoconvertidores compatibles con la CiA402 pueden ser operados fácilmente por el PLC500MC sin que
los usuarios se preocupen por palabra de status, palabra de control, modo de operación y otros parámetros
necesarios para el control de movimiento.

El PLC500MC presenta diversas funcionalidades específicas para el control de movimiento, entre ellas:

Extensa biblioteca con bloques para control de ejes, manipulación y procesamiento de caminhos CNC, grupos
de eje, además de transformaciones cinemáticas populares.

Editor leva CAM integrado.

Editor CNC 3D integrado de acuerdo con DIN 66025 (G-Code).

Configurador de grupos de ejes para diferentes cinemáticas (personalizable).

Fácil comisionamiento de ejes (utilizando Online Configuration Mode).

Bloques de función certificados de acuerdo con PLCopen MotionControl, Part 1 (V20).

Decodificador de G-code, incluyendo soporte para subprogramas y expresiones en G-code.

Bloques de función para probar velocidades de transición.

Bloques de función para lectura y procesamiento de caminos CNC de archivos (para caminos creados y
procesados externamente).

Bloques de función certificados de acuerdo con PLCopen MotionControl Part 4 (movimiento coordinado).
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1.4.1 Editor leva CAM

El PLC500MC tiene un editor de tablas de leva CAM que facilita la visualización e implementación para este
fin.

Alcance del editor leva CAM:

Planeamiento gráfico y numérico para la leva CAM usando cualquier base en representación de distancia,
velocidad, aceleración y jerk.

Interpolación lineal o polinomial (polinomio de 5o orden).

Configuración de los taqués y su comportamiento de conmutación en la leva CAM.

Configuración de levas CAM relativa a requisitos de dimensión, período y continuidad.

Posibilidad de importar y exportar tablas de leva CAM.

Figura 1.3: Editor leva CAM.

Informaciones adicionales referentes al Editor CNC 3D pueden ser encontradas directamente en el sitio de
Codesys, disponible en: https://help.codesys.com (Add-ons > CODESYS SoftMotion > CNC > Editor).

1.4.2 Editor CNC 3D

El PLC500MC tiene la capacidad de interpretar y ejecutar programas G-Code de acuerdo con DIN 66025.

Alcance del editor CNC 3D de acuerdo con DIN 66025 (G-Code):

Editor gráfico y textual simultáneo.

Preprocesamiento de camino (visualización offline de los efectos, por ejemplo, suavización de ángulo).

Preinterpolación de camino (previsualización (offline) de la posición resultante, velocidad, aceleración y
curvas jerk de todos los ejes soportados).

Importar archivos DXF y ASCII (.cnc, .gcode, .txt).

Leer y guardar en archivo.

Transformaciones del programa (girar, desplazar y redimensionar el código G).
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Conversión para tablas.

Informaciones del programa (largo del camino, duración del camino, número de objetos, etc.)

Figura 1.4: Editor CNC 3D.

Informaciones adicionales referentes al Editor CNC 3D pueden ser encontradas directamente en el sitio de
Codesys, disponible en: https://help.codesys.com (Add-ons > CODESYS SoftMotion > CNC > Editor).

1.4.3 Alcance de las bibliotecas SoftMotion + CNC Robotic

Las instrucciones para el control de movimiento son definidas como bloques de función (FB) y pueden ser
utilizadas durante la aplicación para realizar una extensa variedad de movimientos. Las instrucciones para el
control de movimiento son desarrolladas con base en las especificaciones de los bloques de función PLCopen1.
Además de las instrucciones basadas en la PLCopen, también están disponibles bloques adicionales que
facilitan la implementación del control de movimiento.

Bloques de función certificados de acuerdo con PLCopen MotionControl, Parte 1 (V20):

– Posicionamiento absoluto y relativo (MC_MoveAbsolute, MC_MoveRelative).
– Posicionamiento Sobrepuesto (MC_MoveSuperimposed).
– Movimiento en velocidad constante (MC_MoveVelocity).
– Soporte consistente de perfiles con limitación de jerk (aceleración continua para cualquier tipo de
interrupción del movimiento actual).

– Retorno guiado por drive (MC_Home).
– Parada de bloqueo (MC_Stop).
– Liberación de control (MC_Power).
– Lectura y grabación en parámetros (MC_Read/WriteParameter).
– Lectura de la posición real (MC_ReadActualPosition).
– Perfiles de posición, velocidad y aceleración (MC_*Profile).
– Definir y mover la posición (MC_SetPosition).
1La PLCopen es una organización que promueve el control industrial, con base en la norma IEC61131-3. Para más informaciones sobre

el PLCopen, consulte el sitio oficial en: http://www.plcopen.org/.
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– Lectura de la velocidad real y el torque real (MC_ReadActualVelocity, MC_ReadActualTorque).
– Conmutación de leva CAM (MC_DigitalCamSwitch).
– Engranaje electrónico con posición de sincronización (MC_GearInPos).
– Parada completa (MC_Halt).
– Rastreo de señales maestras respetando los límites de velocidad, aceleración y jerk
(SMC_TrackSetValues).

– Bloques adicionales.
– Control y consulta del frenado.
– Monitoreo del error de arrastre, una ventana de posición o valores máximos.
– Medición de distancia recorrida.
– Gestión de errores en los bloques de función.
– Retorno guiado por el controlador (MC_Homming).
– Comisionamiento de dispositivos.
– Posicionamiento absoluto y relativo con velocidad de transición (SMC_MoveContinuousAbsolute y
SMC_MoveContinuousRelative)

– Configuración del modo de control (posición, velocidad o torque).

Modelos de visualización para los bloques de función más importantes utilizados para el comisionamiento
rápido integrado en el software Codesys.

Decodificador de código G.

Soporte para subprogramas y expresiones en código G.

Limitador para restringir los valores de dinámicas de velocidad y aceleración para uno o más ejes.

Bloques para probar velocidades en las transiciones.

Interpolador para calcular los puntos del camino CNC con base en el perfil de velocidad.

Bloques para transformación de coordinadas (SMC_ScaleQueue3D y
SMC_CoordinateTransformation3D).

Bloques de transformación (incluyendo inversa) para cinemáticas populares:

– Sistemas pórticos (gantry) 2D / 3D.
– Sistemas pórticos (gantry) con ejes de orientación y compensación de herramienta.
– Sistemas pórticos (gantry) con accionamiento por correa (portales H y portales T).
– Transformación polar.
– SCARA de 2/3 brazos.
– Bipod.
– Tripod con ejes lineares y articulados.
– Cinemática de 5 ejes para portal de 3 ejes con herramienta rotativa y basculante.
– Cinemática de 4 ejes para robots de paletización.
– Cinemática de 6 ejes para robots de brazo articulado.

Bloques para lectura y procesamiento de caminos CNC de un archivo (para caminos creados y procesados
  externamente).

Modos de velocidad de camino trapezoidal/sigmoidal/cuadrático/cuadrático suave.

Función hodómetro.

Transformación de coordinadas 3D parametrizable (incluyendo inversa).

Biblioteca de funciones certificada con bloques de función de acuerdo con PLCopen Motion, Part 4
(movimiento coordinado).

– Bloques administrativos: MC_GroupEnable/Disable/Reset/ReadError, etc.
– Comandos de movimiento: MC_MoveDirectAbsolute, MC_MoveDirectRelative, MC_MoveCircular*,
MC_MoveLinear*, MC_GroupHalt, MC_GroupStop.
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– Seguimiento: MC_TrackConveyorBelt, MC_TrackRotaryTable, MC_SetDynCoordTransform.
– Modo jog en cualquier sistema de coordinadas: SMC_GroupJog2.
– Soporte de diferentes sistemas de coordinadas: coordinadas globales (WCS), coordinadas de máquina
(MCS), diversas coordinadas del producto (PCS_1, PCS_2), coordinadas de la herramienta (TCS) y
coordinadas del eje (ACS).

Soporte para espera en el camino con tiempo de espera (SMC_GroupWait).

Interfaz pública y documentada para crear cinemática específica del usuario en el lenguaje IEC 61131-3.

Cinemática de orientación adicional, que puede ser combinada con las otras cinemáticas.

Herramientas con orientación y desplazamiento de posición.
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2 CREAR Y CONFIGURAR LA RED ETHERCAT + SOFTMOTION

En esta sección son descritas las etapas necesarias para realizar una comunicación EtherCAT entre el
PLC500MC y el servoconvertidor SCA06, a través del software Codesys. En las demás secciones de esta
nota de aplicación serán presentadas Informaciones adicionales y configuraciones avanzadas o podrán ser
encontradas directamente en el sitio de Codesys, disponible en: https://help.codesys.com.

2.1 COMPONENTES UTILIZADOS
Los componentes necesarios para este manual de aplicación:

Componente Versión FW
PLC500MC 1.2.0 o superior

Servoconversor SCA06 2.11 o superior
Servomotor Compatible con el servoconvertidor

Accesorio EtherCAT ECO4 Rev. 2436 o superior
Tabla 2.1: Componentes necesarios.

Para los componentes pasivos de red (cables, conectores y fuente de alimentación), utilice solamente
componentes certificados para aplicaciones industriales. Consulte la documentación de los productos para
más informaciones sobre la instalación adecuada del servoconvertidor SCA06 y del servomotor utilizado.

2.2 ARQUITECTURA DE RED

La Figura 2.1 muestra la topología de la red utilizada, la computadora debe estar conectada al PLC500MC
a través de la interfaz ETH1 o USB2. La comunicación EtherCAT con el servoconvertidor SCA06 utilizará la
interfaz ETH2 del PLC500MC.

Figura 2.1: Arquitectura de red.

2.3 CONFIGURACIÓN DEL SERVOCONVERTIDOR SCA06

Conecte correctamente el accesorio EtherCAT ECO4 y el servomotor al servoconvertidor SCA06.

Partiendo de los parámetros de estándar de fábrica del SCA06:

Altere el parámetro P0202 a 5 (control vía red CAN/EtherCAT).
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Altere el parámetro P0385 para configurar el modelo del motor, conforme la placa de éste y la tabla de
motores.

Siga las recomendaciones descritas en el manual del usuario del servoconvertidor SCA06 para programar
parámetros de ajuste del equipo, relativos a la parametrización del motor, funciones deseadas para las señales
de I/O, etc...

En caso de duda, consulte el Manual de Programación del servoconvertidor SCA06.

Reinicie el servoconvertidor.

Con eso, el servoconvertidor SCA06 estará pronto para ser accedido a través de la red EtherCAT.

2.4 CREAR UN PROYECTO EN EL CODESYS

Haga el download del software Codesys y la instalación delWEG Package conforme el manual del PLC500.
Luego de la instalación, abra el Codesys y cree un nuevo proyecto en File > New Project. Seleccione
Standard Project, defina un directorio y el nombre de la aplicación. Seleccione el Device PLC500MC y
el lenguaje de programación deseado, conforme la Figura 2.2.

Figura 2.2: Configuración del proyecto en el Codesys.

Al crear una aplicación para el Dispositivo PLC500MC, las interfaces de red estándar se preconfigurarán
automáticamente, conforme la Figura 2.3.

Figura 2.3: Interfaces PLC500MC
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2.4.1 Agregar EtherCAT Master SoftMotion

Para agregar una nueva interfaz de comunicación EtherCAT Master SoftMotion haga clic con el botón
derecho encima del Device (PLC500MC), haga clic en Add Device, en la caja de diálogo seleccione
Fieldbuses > EtherCAT > Master > EtherCAT Master SoftMotion haga clic en Add Device para agregar
al árbol de dispositivos, conforme la Figura 2.4.

Figura 2.4: Agregando EtherCAT Master SoftMotion al árbol de dispositivos.

Al agregar la interfaz de comunicación EtherCAT Master SoftMotion automáticamente será creada una tarea
llamada EtherCAT_Task2.

2.4.2 Agregar SCA06_SoftMotion como esclavo en la red EtherCAT

Para agregar el dispositivo SCA06_SoftMotion como esclavo de la red EtherCAT haga clic con el botón
derecho en el dispositivo EtherCAT Master Softmotion creado anteriormente y seleccione la opción Add
Device.)

En la sección Action, de la caja de diálogo abierta, asegúrese de que la opción Append device esté
seleccionada. Busque el dispositivo SCA06_SoftMotion, éste se encuentra dentro de la carpeta WEG >
Servo Drives.

Haga clic en Add Device.

La Figura 2.5 presenta los pasos anteriores, directamente en el software Codesys.

2Tarea utilizada para los comandos de control de movimiento SoftMotion.
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Figura 2.5: Agregando SCA06_SoftMotion como esclavo en la red EtherCAT.

¡NOTA!
Es importante agregar la unidad SoftMotion, ya que la unidad estándar, importada por un XML, no
contiene un eje SoftMotion asociado (el SCA06_SoftMotion es instalado junto al WEG Package).

Luego de estas configuraciones, el árbol de dispositivos deberá contener los íconos presentados en la
Figura 2.6.

Figura 2.6: Árbol de dispositivos para utilización del SoftMotion.

2.4.3 Configurar EtherCAT Master SoftMotion

Abra las configuraciones del dispositivo EtherCAT Master SoftMotion, en la pestaña General, seleccione
la opción Autoconfig Master/Slave. Con eso, las principales configuraciones de maestro/esclavo/ serán
hechas automáticamente, con base en el archivo de descripción del dispositivo.

Configure las demás opciones de la página, conforme la Figura 2.7
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Figura 2.7: Configuración estándar EtherCAT Master SoftMotion.

Las informaciones sobre configuraciones avanzadas serán presentadas en la sección 4 o pueden ser
encontradas directamente en el sitio de Codesys, disponible en: https://help.codesys.com (Fieldbus Support
> EtherCAT > Configuration).

2.4.4 Configurar SCA06_SoftMotion

Utilizando la opción Autoconfig Master/Slave en el EtherCAT Master Softmotion la configuración del
servoconvertidor SCA06_SoftMotion será hecha automáticamente.

Las informaciones sobre configuraciones avanzadas serán presentadas en la sección 4 o pueden ser
encontradas directamente en el sitio de Codesys, disponible en: https://help.codesys.com (Fieldbus Support
> EtherCAT > Configuration).

2.4.5 Configurar SM_Drive_ETC_WEG_SCA

Abra las configuraciones del SM_Drive_ETC_WEG_SCA.

En la pestaña General se encuentran las configuraciones referentes al tipo y a los límites del eje, tipo de la
rampa de velocidad y supervisión de arrastre.

Configure la página conforme la Figura 2.8.

Figura 2.8: Configuración estándar SM_Drive_ETC_WEG_SCA.
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Esta configuración define el eje como finito, limitación por software deshabilitada, rampa de velocidad del tipo
trapezoidal, ID del eje igual a 0, sin supervisión de arrastre y con los límites de dinámica3 definidos en el campo
Dynamic limits.

Haga clic en la pestaña Scaling/Mapping.

En la pestaña Scaling/Mapping se puede definir la relación entre las unidades de aplicación (por ejemplo,
milímetros o grados) y la unidad del servoconvertidor (pulsos).

Configure la página conforme la Figura 2.9.

¡NOTA!
Es posible mapear manualmente las variables del SM_Drive_ETC_WEG_SCA. Para eso, en el
campo Mapping, desmarque la opción Automatic mapping.

Figura 2.9: Configuración estándar de escala SM_Drive_ETC_WEG_SCA.

Esta configuración define que 65536 pulsos del servomotor equivaldrán a una unidad de aplicación, o sea, cada
unidad de aplicación será exactamente igual a un giro en el servomotor4

¡ATENCIÓN!
Es imprescindible la correcta configuración de estos valores, ya que los bloques de función
SoftMotion utilizarán la unidad de aplicación como parámetro para el movimiento.

Las Informaciones sobre configuraciones avanzadas serán presentadas en la sección 5 o podrán ser
encontradas directamente en el sitio de Codesys, disponible en: https://help.codesys.com (Add-ons >
CODESYS SoftMotion > Reference > User Interface > Objects > SoftMotion Drives).

Luego de aplicadas las configuraciones de esta sección haga el download del programa para el PLC500MC
y monitoree en modo Online.

3Estos límites son tomados en consideración cuando es utilizado un grupo de ejes (PLCopen Parte 4). Además de eso, son usados por
los bloques de función SMC_ControlAxisBy* para detectar saltos.

4El servoconvertidor SCA06 tiene la resolución de 65536 pulsos por vuelta, consulte el manual EtherCAT del SCA06 para más
informaciones..
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2.5 MONITOREO

2.5.1 Estado de la comunicación EtherCAT

El estado de la red EtherCAT puede ser monitoreado en el modo Online del Codesys, indicando el estado de
cada una de las etapas de comunicación y informando el estado (Status). Al encontrar problemas de conexión
como es mostrado en la Figura 2.10, verifique nuevamente si los cables están debidamente conectados y revise
las configuraciones hechas en la sección 2.

Figura 2.10: Indicación de error en la comunicación EtherCAT.

Cuando las configuraciones estén correctas y los dispositivos estén comunicando adecuadamente, todos los
ítems de la comunicación EtherCAT estarán en verde, como es indicado en la Figura 2.11.

Figura 2.11: Comunicación correctamente configurada y dispositivos comunicado.

2.5.2 Verificar la variación en la posición actual del servomotor

Luego de una correcta configuración de la red EtherCAT, y también en el modo Online, abra las
configuraciones del SM_Drive_ETC_WEG_SCA.
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Cuando el PLC esté en modo Online, en la pestaña General, será habilitado un campo para visualización del
eje, conforme la Figura 2.12.

Figura 2.12: Monitoreo online del servomotor.

En este campo es posible observar el estado del eje y de la comunicación, variables de posición, velocidad,
aceleración y torque, con sus referencias y valores actuales.

Mueva el eje del servomotor manualmente y observe el valor de la posición, alterando en Position [u] - actual
value.

2.6 COMISIONAMIENTO

Es posible probar las configuraciones aplicadas para el servoconvertidor SCA06 a través de los pasos
presentados en esta subsección.

Salga del modo Online y entre nuevamente en el PLC, utilizando la opción Online Config Mode. Este es
el modo para configuración del PLC, a través de él es posible probar y validar las configuraciones aplicadas
para el servoconvertidor.

¡ATENCIÓN!
Al utilizar la opción Online Config Mode, la aplicación presente en el PLC será automáticamente
borrada.

Para utilizar la opción Online Config Mode, en la árbol de dispositivos, haga clic en PLC500MC y en seguida
haga clic en la opción Online Config Mode, como es presentado en la Figura 2.13
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Figura 2.13: Online Config Mode.

Abra las configuraciones del servomotor (SM_Drive_ETC_WEG_SCA) y haga clic en la pestaña
Commissioning. En esta pestaña, además de las variables y del status del eje, quedan disponibles
algunos botones para el accionamiento del servomotor, como es presentado en la Figura 2.14.

¡NOTA!
Esta página solamente es habilitada utilizando la opción Online Config Mode.

Figura 2.14: Comisionamiento SCA06_SoftMotion.

¡ATENCIÓN!
Se puede mover el eje utilizando los botones de esta página. El eje puede ejecutar movimientos
inesperados en caso de que las configuraciones no estén adecuadas. Tome todas las
precauciones de seguridad necesarias.
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Elementos de operación Descripción
Power El Drive es habilitado (equivalente al bloque de función

MC_Power).
Error reset Reinicia Drive tras un error (equivalente al bloque de

función MC_Reset).
Start homing El Drive ejecuta el comando homing con los parámetros

definidos internamente en el servoconvertidor
(equivalente al bloque de función MC_Home)*.

Jogging mode Utilizando los botones < y > se puede mover el eje
hacia adelante y hacia atrás, de acuerdo con los valores
especificados para Distance, Velocity, Acceleration,
Deceleration y Jerk (equivalente al bloque de función
MC_Inch).

ReadWrite Para el parámetro del convertidor especificado, el valor
(Value) actual es leído por el PLC y exhibido. en
Prepared value, se puede especificar un nuevo valor
y escribirlo en el parámetro del drive (equivalente
a los bloques de función MC_ReadParameter y
MC_WriteParameter).

Tabla 2.2: Elementos de comisionamiento.

Haga clic en el botón Power para habilitar el servoconvertidor, en seguida mantenga presionado el botón >.
El servomotor deberá realizar una vuelta completa y parar.

Si lo desea, pruebe algunos comandos más y salga del modo Online Config Mode.
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3 APLICACIÓN SOFTMOTION

Esta sección presenta los pasos necesarios para la creación de una aplicación SoftMotion para el control de
un eje simple.

3.1 CREAR APLICACIÓN

Para una aplicación SoftMotion es necesario crear un POU específico que será utilizado para el movimiento de
los ejes.

Utilice como base las configuraciones presentadas en la sección 2.4.

En el árbol de dispositivos, haga clic con el botón derecho en el objeto Application > Add Object > POU...

Cree un POU del tipo Program con el nombre MyMotion.

En el campo Implementation language, seleccione la opción Structured Text (ST).

Haga clic en Add.

La Figura 3.1 presenta los pasos anteriores directamente por el Codesys.

Figura 3.1: Crear POU SoftMotion.

Este POU debe ser llamado bajo la tarea EtherCAT_Task.

¡NOTA!
Todos los bloques de función relativos al movimiento de los ejes deben ser declarados y llamados
en la EtherCAT_Task. las demás funcionalidades deben ser utilizadas en tareas diferentes, con
una menor prioridad.

Arrastre el POU MyMotion bajo la tarea EtherCAT_Task, como apresentado na Figura 3.2.

PLC500MC | 3-1



APLICACIÓN SOFTMOTION

Figura 3.2: Agregar el POU MyMotion a la tarea EtherCAT_Task.

Abra el POU MyMotion.

Cree una instancia MC_Power y otra MC_MoveRelative y referencie la entrada Axis de los bloques de
función al nombre del eje creado, conforme es presentado en la Figura 3.3.

Figura 3.3: Agregar el POU MyMotion a la tarea EtherCAT_Task.

Aplicación MyMotion:
PROGRAM MyMotion
VAR
MC_Power_0 : MC_Power;
MC_MoveRelative_0 : MC_MoveRelative;

END_VAR
MC_Power_0(
Axis:= SM_Drive_ETC_WEG_SCA);

MC_MoveRelative_0(
Axis:= SM_Drive_ETC_WEG_SCA);
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3.2 CREAR VISUALIZACIÓN

¡NOTA!
La biblioteca SM3_Basic tiene diversos modelos de visualización integrados que pueden ser
usados para probar la funcionalidad de un bloque de función de manera simplificada.

Agregue un objeto del tipo Visualization en el árbol de dispositivos, conforme la Figura 3.4.

Figura 3.4: Agregar el objeto del tipo Visualization.

Al agregar un objeto del tipo Visualization, será abierta una caja de diálogo, como en la Figura 3.5.

Figura 3.5: Caja de diálogo abierta al agregar un objeto del tipo Visualization.

Marque la opción Active y haga clic en OK.

Abra el objeto Visualization creado.

En el campo Visualization Toolbox, ubicado en el lado derecho de la pantalla, seleccione la pestaña
SM3_Basic. En el campo de búsqueda digite MC_Power y seleccione el modelo VISU_NEW_MC_Power,
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conforme apresentado na Figura 3.6.

Figura 3.6: Buscar el modelo de visualización MC_Power.

Arrastre y suelte el modelo en la visualización.

Al soltar el objeto, una caja de diálogo Assign parameters será abierta para el modelo de visualización.

Haga doble clic en Value t haga clic en ....

Con eso, una nueva caja de diálogo Input Assistant será abierta.

Busque la instancia del bloque de función MC_Power_0 creada en el POU MyMotion y haga clic en OK.

La Figura 3.7 presenta los pasos anteriores directamente por el Codesys.

Figura 3.7: Agregar el objeto del tipo Visualization.
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Con eso, las entradas y salidas del modelo de visualización son mapeadas automáticamente para la instancia
del bloque de función.

¡NOTA!
Otra forma de mapear el modelo de visualización al bloque de función creado puede ser hecha
seleccionando el modelo y usando la pestaña Properties > References > m_Imput_FB.

Haga el mismo procedimiento, ahora utilizando el modelo VISU_NEW_MC_MoveRelative, referenciando la
instancia del bloque de función MC_MoveRelative_0.

Luego de la configuración, la página de visualización deberá contener estos dos modelos de visualización
mapeados en los bloques de función creados anteriormente, como en la Figura 3.8.

Figura 3.8: Agregar el objeto del tipo Visualization.

A través de estos modelos será posible controlar el eje del servomotor.

Haga el download del programa para el PLC500MC.

En el modo de monitoreo Online, abra el objeto Visualization.

¡ATENCIÓN!
Se puede mover el eje por medio de botones en esta página. El eje puede ejecutar movimientos
inesperados, en caso de que las configuraciones no estén adecuadas. Tome todas las
precauciones de seguridad necesarias.

En el modelo MC_Power, haga clic en los botones bDriveStart, bRegulatorOn y Enable respectivamente.

Observe las salidas del bloque, éstas mostrarán el estado del servoconvertidor. Para el correcto accionamiento,
las salidas Status, bRegulatorOnRealState y bRegulatorOnRealState deberán estar en verde, como en la
Figura 3.9, indicando la habilitación del servoconvertidor para movimiento.

Figura 3.9: Ejemplo de servomotor habilitado.
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En el modelo MC_MoveRelative, ajuste las variables relativas al movimiento (Distance, Velocity,
Acceleration, Deceleration y Jerk) como es presentado en la Figura 3.10. Luego de eso, haga clic en el
botón Execute para iniciar el movimiento.

Figura 3.10: Ejemplo de configuración de movimiento relativo para el servomotor.

Si lo desea, realice algunas pruebas más.

Otros ejemplos de aplicación pueden ser encontrados directamente en el sitio de Codesys, disponible en:
https://help.codesys.com (Add-ons > CODESYS SoftMotion > Application Examples).
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4 INFORMACIONES ADICIONALES DE LA RED ETHERCAT

En este capítulo serán presentadas algunas informaciones adicionales y configuraciones avanzadas utilizadas
en la red EtherCAT.

4.1 ATRIBUIR UNA DIRECCIÓN ESTÁTICA PARA EL SCA06 EN LA RED ETHERCAT

Es posible definir una dirección estática para elSCA06 como esclavo en la red EtherCAT utilizando unamemoria
EEPROM interna del accesorio ECO4.

Utilice como base las configuraciones presentadas en la sección 2.4.

Abra las configuraciones del SCA06_Motion, en la pestaña General, habilite la opción Expert settings,
luego de eso quedarán disponibles diversas configuraciones avanzadas.

En el campo Identification, seleccione la opción Configured statio alias (ADO 0x012), conforme la
Figura 4.1.

Figura 4.1: Habilitando identificación.

Luego de aplicadas las configuraciones de esta sección, haga el download del programa en el PLC500MC y
monitoree en modo Online.

En el modo Online, al establecer una comunicación con el SCA06_Motion, en el campo Identification, la
variable Actual adress aparecerá informando el valor actual de la dirección. La opción Write to EEprom
también estará disponible, como en la Figura 4.2.
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Figura 4.2: Dirección actual en la memoria EEPROM.

Digite la dirección deseada en el campo Value y haga clic en la opciónWrite to EEprom, como es presentado
en la Figura 4.3.

Figura 4.3: Escribiendo nueva dirección en la memoria EEPROM.

Aparecerá en la pantalla un mensaje, como en la Figura 4.4, solicitando que el servoconvertidor sea reiniciado
para aplicar la nueva dirección de red.

Figura 4.4: Mensaje de aviso para aplicar la escritura EEPROM.

Reinicie el servoconvertidor.

Salga del modo Online, en el campo Additional, seleccione la opción Optional. En el campo Configured
statio alias (ADO 0x012), como es presentado en la Figura 4.5. Asegúrese de que la dirección es la mismo
que fue escrita en la memoria EEPROM anteriormente.
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Figura 4.5: Habilitar el campo Optional.

Haga el download del programa en el PLC500MC y monitoree en modo Online.

Observe que ahora la dirección actual será la dirección escrita en la EEPROM del dispositivo, como es
presentado en la Figura 4.6.

Figura 4.6: Nueva dirección EEPROM.

¡NOTA!
Para utilizar la dirección escrita en la memoria EEPROM en una red con más de un SCA06 es
necesario que los dispositivos estén marcados con la opción Optional, en caso contrario, la red
será configurada automáticamente por el maestro de la red, sin utilizar la dirección de la memoria
EEPROM.

4.2 LEER Y EDITAR PARÁMETROS EN EL SCA06 POR LA RED ETHERCAT

Utilizando este método es posible modificar parámetros de configuración del SCA06 remotamente a través de
la red EtherCAT, sin necesidad de utilizar su IHM.

Utilice las configuraciones presentadas en la sección 2.4.

En el modo Online, abra las configuraciones del esclavo EtherCAT (SCA06_SoftMotion), en la pestaña
General, habilite la opción Expert setting.

Abra la pestaña CoE Online y seleccione la opción Auto Update, conforme la Figura 4.7.

PLC500MC | 4-3



INFORMACIONES ADICIONALES DE LA RED ETHERCAT

Figura 4.7: CoE Online

Elementos de operación Descripción
Read Objects El directorio de objetos es leído una vez.
Auto update Los objetos son leídos en ciclos.

Offline from ESI file La pestaña muestra el contenido del directorio de objetos
de la descripción del dispositivo.

Online from Device La pestaña muestra el contenido del directorio de objetos
del dispositivo (No disponible para el SCA06).

Flags RO: El valor es protegido contra escritura. RW: El valor
puede ser modificado.

Value Es posible hacer clic dos veces en el campo de texto para
editar ese valor. El nuevo valor será escrito directamente
en el SCA06.

Tabla 4.1: Elementos CoE Online.

A través de esta pestaña es posible leer y modificar algunos parámetros internos del servoconvertidor SCA06.

Haga una prueba modificando el parámetro P1249, al valor 15.

Encuentre el parámetro P1249 - User Parameter en la lista, haga clic dos veces en el campo Value, digite
15 y presione Enter, como es presentado en la Figura 4.8.

¡NOTA!
Las variables serán actualizadas en ciclos, aguarde la lectura de los parámetros, eso puede llevar
algunos minutos.
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Figura 4.8: Editar parámetros Online

Con eso, el valor será modificado.

Verifique la escritura de este valor directamente por la IHM del SCA06, en el parámetro P1249.

4.3 EDITAR PDOS EN LA RED ETHERCAT

Es posible editar los PDOs, definidos de forma estándar, del SCA06 en la comunicación EtherCAT.

Utilice las configuraciones presentadas en la sección 2.4.

Abra las configuraciones delSCA06_Motion, en la pestañaGeneral, habilite la opciónExpert settings, luego
de eso quedarán disponibles diversas configuraciones avanzadas, como es presentado en la Figura 4.9.
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Figura 4.9: Habilitar configuraciones avanzadas SCA06_SoftMotion.

Acceda a la pestaña Expert Process Data, en esta pestaña será posible modificar los PDOs de la
comunicación.

Figura 4.10: Editar PDOs de la red EterCAT.

Seleccione el PDO que usted desea modificar en el campo PDO List y enseguida edítelo en el campo PDO
Content.

Para aplicar la nueva configuración de PDOs asegúrese de que en el campo Download las opciones PDO
Assigment y PDO configuration estén seleccionadas.

Utilizando este procedimiento, al hacer el Download del programa en el PLC500MC e iniciar la comunicación
EtherCAT con el servoconvertidor SCA06, la lista será automáticamente modificada con la nueva configuración
de PDOs.

4.4 CONFIGURAR REDUNDANCIA ETHERCAT

Es posible configurar una red EtherCAT con redundancia utilizando el PLC500MC.
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¡NOTA!
Los puertos ETH1 y ETH2 son puertos independes, de esta forma, no es posible realizar una
comunicación EtherCAT en anillo, sin embargo, es posible realizar una comunicación EtherCAT
con redundancia.

Utilice las configuraciones presentadas en la sección 2.4.

Abra las configuraciones del dispositivo EtherCAT Master SoftMotion.

Marque la opción Redundancy.

En el campo Redundancy EtherCAT NIC Settings, marque la opción Select network by name.

En el campo Network name, digite ETH1.

La Figura 4.11 presenta las configuraciones anteriores ya realizadas.

Figura 4.11: Configurar redundancia EtherCAT.

Con eso, la redundancia de la red ya estará configurada y pronta para ser utilizada.

4.5 ARCHIVO XML
Cada dispositivo en una red EtherCAT tiene un archivo de configuración XML que contiene informaciones sobre
el funcionamiento del dispositivo en la red EtherCAT, así como la descripción de todos los objetos existentes
para comunicación. en general, este archivo es utilizado por un maestro o software de configuración para la
programación de los dispositivos presentes en la red.

¡ATENCIÓN!
Es posible agregar dispositivos esclavos EtherCAT al software Codesys utilizando archivos del
tipo XML. No obstante, para el control de movimiento es recomendado que sean utilizados
los dispositivos ya instalados y específicos para este fin. Usted podrá agregar un eje
genérico siguiendo la CiA402, sin embargo, algunas funcionalidades SoftMotion podrán no estar
disponibles.
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5 INFORMACIONES ADICIONALES SOFTMOTION

En este capítulo serán presentadas algunas informaciones adicionales y configuraciones avanzadas utilizadas
para el control de movimiento.

5.1 PRIORIDAD DE TAREAS

El control de movimiento necesita una alta prioridad para su correcto funcionamiento. de esta manera, es
imprescindible una correcta configuración de la prioridad de las tareas.

Se debe definir 1 para la tarea responsable por el control de movimiento. Cuando sea agregado un dispositivo
maestro EtherCAT, éste creará una tarea (con prioridad 1) automáticamente. La aplicación responsable por el
control de movimiento deberá ser ejecutada bajo esta tarea.

Las demás aplicaciones, además del control de movimiento, o que poseen un alto consumo computacional,
deben ser ejecutadas en una tarea diferente y con una prioridad menor. Se recomienda la prioridad 10 o menor
(10 - 31) para estas tareas.

¡NOTA!
Cuanto menor sea el número mayor será su prioridad, siendo 0 la tarea más prioritaria y 31 la
menos prioritaria.

La Figura 5.1 presenta un ejemplo de configuración de tareas, donde el control de movimiento es ejecutado en
el programa MyMotion y las demás funcionalidades son ejecutados en el programa PLC_PRG.

Figura 5.1: Editar prioridad de tareas.

5.2 CONFIGURACIONES DE ESCALA PARA EL SM_DRIVE_ETC_WEG_SCA

En esta subsección será presentada las posibles configuraciones de escala aplicadas al eje
SM_Drive_ETC_WEG_SCA.

Utilice como base las configuraciones presentadas en la sección 2.4.

Abra las configuraciones del SM_Drive_ETC_WEG_SCA, en la pestaña Scaling/Mapping.

Para las configuraciones de escala es posible utilizar dos tipos motores, escogida a través del campo Motor
Type. Dependiendo del tipo de motor seleccionado el campo Scaling, las configuraciones disponibles serán
diferentes.

PLC500MC | 5-1



INFORMACIONES ADICIONALES SOFTMOTION

5.2.1 Motor Type: Rotary

Rotary: Generalmente utilizada para configuraciones de ejes rotativos ya que tiene una configuración
más completa, pudiendo agregar relación de engranajes o poleas. La Figura 5.2 presenta un ejemplo de
configuración utilizando el Motor Type: Rotary.

Figura 5.2: Ejemplo de configuración utilizando Motor Type: Rotary.

Cada valor del campo Scaling puede ser alterado de acuerdo con la mecánica involucrada en la aplicación.

Elementos de operación Descripción
increments <=> motor turns Número de incrementos que corresponden a un

determinado número de vueltas del motor.
motor turns <=> gear output turns Número de vueltas del motor que corresponden a un

determinado número de vueltas en la salida de la
engranaje.

gear output turns <=> units in application Número de vueltas en la salida de la engranaje que
corresponden a unidades de aplicación.

Tabla 5.1: Elementos Scaling.

Para esta configuración cada unidad de aplicación equivaldrá a 1/6 de vuelta del servomotor.

5.2.2 Motor Type: Linear

Linear: generalmente utilizada para configuraciones de ejes lineares ya que tiene una configuración más
simplificada y directa. La Figura 5.3 presenta un ejemplo de configuración utilizando el Motor Type: Linear.

Figura 5.3: Ejemplo de configuración utilizando Motor Type: Linear.

Elementos de operación Descripción
increments <=> units in application Número de incrementos que corresponden a unidades

de aplicación
Tabla 5.2: Elementos Scaling.

Para esta configuración cada unidad de aplicación equivaldrá a 1 de vuelta del servomotor.

¡NOTA!
Al seleccionar la opción Invert direction el sentido de giro será invertido. El servoconvertidor
recibirá los valores de referencia con señales opuestas.
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En el sitio de Codesys pueden ser encontradas más informaciones sobre las configuraciones, disponible en:
https://help.codesys.com (Add-ons > CODESYS SoftMotion > Reference > User interfaz > Objects > SoftMotion
Drives).

5.3 AGREGAR EJE VIRTUAL

Las Virtual Drive son unidades simuladas en software. Con eso, usted puede probar sus programas sin un
hardware conectado o implementar funcionalidades extendidas utilizando ejes virtuales.

Para agregar un eje virtual en una aplicación, siga los pasos presentados a continuación.

Haga clic con el botón derecho en SoftMotionGeneral axis pool en el árbol de dispositivos, seleccione la
opción Add device.

Seleccione el dispositivo SoftMotionDrives > virtual drives > SM_Drive_Virtual en la caja de diálogo Add
Device.

Haga clic en Add Device.

La Figura 5.4 presenta los pasos anteriores directamente por el Codesys.

Figura 5.4: Agregar eje virtual.

Con eso, será agregado un eje virtual debajo del objeto SoftMotionGeneral axis pool. La Figura 5.5 presenta
el árbol de dispositivos con un eje virtual agregado.

Figura 5.5: Árbol de dispositivos con eje virtual agregado.

Abra las configuraciones del SM_Drive_Virtual.

En la pestaña General, pueden ser configuradas las configuraciones de tipo de eje, límites, rampa de
aceleración y dinámica límite.

Configure la pestaña General, de acuerdo con la Figura 5.6.
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Figura 5.6: Ejemplo configuraciones de eje virtual.

Luego de asas configuraciones, el eje virtual podrá ser usado en sus aplicaciones.

Más informaciones sobre ejes virtuales pueden ser encontradas directamente en el sitio de Codesys, disponible
en: https://help.codesys.com (Add-ons > CODESYS SoftMotion > Reference > User interfaz > Objects >
SoftMotion Drives > Tab ‘Logical Axes’).

5.4 AGREGAR EJE ENCODER

Es posible utilizar las dos entradas del tipo encoder del PLC500MC como Drives SoftMotion. Para eso,
configure la entrada DI1 del PLC500MC como encoder (I_Os > DI1 / Encoder1 > Pin type > Pulse/Direction
o Quadrature).

La Figura 5.7 presenta los pasos anteriores directamente por el Codesys.

Figura 5.7: Configurar DI como encoder.

De esta forma las entradas DI1 y DI2 del PLC500MC dejan de ser entradas digitales y pasan a ser entradas
para encoder.

Utilice como base las configuraciones presentadas en la sección 3.

Haga clic con el botón derecho en SoftMotion General Axis Pool en el árbol de dispositivos.

Haga clic en Add Device...

En la pestaña Add Device, en el campo Action, seleccione la opción Append device.

Seleccione el dispositivo SoftMotion drives > Free Encoder > SMC_FreeEncoder en la caja de diálogo.

Haga clic en Add Device.

La Figura 5.8 presenta los pasos anteriores directamente por el Codesys.
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Figura 5.8: Agregando eje encoder.

Con eso, será agregado al árbol de dispositivos en eje del tipo SMC_FreeEncoder, conforme a Figura 5.9.

Figura 5.9: Drive Encoder agregado al árbol de dispositivos.

Abra las configuraciones del SMC_FreeEncoder, en la pestaña Scaling, haga la configuración adecuada
para el tipo de encoder utilizado en su aplicación.

La Figura 5.10 presenta un ejemplo de configuración donde mil pulsos en el encoder corresponderán a una
unidad de aplicación.

Figura 5.10: Drive Encoder agregado al árbol de dispositivos.

Para que el valor actual del Drive adicionado sea actualizado con el valor de la entrada de encoder del
PLC500MC es necesario atribuir su valor para variable <FREE_ENCODER_AXIS>.diEncoderPosition, eso
debe ocurrir en la tarea responsable por el movimiento (EtherCAT_Task). Es necesaria también la conversión
del tipo de la variable de LINT a DINT, utilice la función LINT_TO_DINT() para eso.

El campo de abajo presenta un ejemplo del comando que debe ser utilizado para atribuir el valor de
contener_Encoder1 para la variable del drive SMC_FreeEncoder.
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SMC_FreeEncoder.diEncoderPosition := LINT_TO_DINT(counter_Encoder1);

¡NOTA!
También es posible utilizar los bloques de función disponibles en la biblioteca IoDrvGPIO (WEG)
para actualizar los valores de la posición del encoder.

Abra el POU MyMotion, agregue el comando para atribuir el valor del encoder al drive SMC_FreeEncoder,
como apresentado na Figura 5.11.

Figura 5.11: Agregando el comando al POU asociado al movimiento.

Aplicación MyMotion:
PROGRAM MyMotion
VAR
MC_Power_0 : MC_Power;
MC_MoveRelative_0 : MC_MoveRelative;

END_VAR
SMC_FreeEncoder.diEncoderPosition := LINT_TO_DINT(counter_Encoder1);

MC_Power_0(
Axis:= SM_Drive_ETC_WEG_SCA);

MC_MoveRelative_0(
Axis:= SM_Drive_ETC_WEG_SCA);

Conecte un encoder a las entradas DI1 y DI2.

Haga el download del programa en el PLC500MC y monitoree en modo Online.

Abra las configuraciones del SMC_FreeEncoder en la pestaña Encoder, como es presentado en la
Figura 5.12.
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Figura 5.12: Monitoreando encoder.

Mueva el eje encoder y observe el valor de la posición alterando en Position [u] - actual value.

Más informaciones sobre ejes de encoder pueden ser encontradas directamente en el sitio de Codesys,
disponible en: https://help.codesys.com (Add-ons > CODESYS SoftMotion > Reference > User Interface >
Objects > SoftMotion Drives > Tab ‘Encoder’).
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5.5 SINCRONIZACIÓN LEVA CAM

Una leva CAM describe la dependencia funcional de movimiento de una unidad (esclavo) con relación a otra
unidad (maestro). La relación es descrita por una función continua (o curva) que mapea un rango definida de
valores del maestro para valores del esclavo.

5.5.1 Crear aplicación leva CAM

En esta subsección serán presentadas las configuraciones necesarias y los bloques de función utilizados para
ejecutar un movimiento de leva CAM utilizando ejes virtuales.

Cree un proyecto nuevo en File > New Project. Seleccione Standard Project, defina un directorio y el
nombre de la aplicación (Example_Cam). seleccione el dispositivo PLC500MC y el lenguaje de programación
Continuos Funcion Chart (CFC).

En el árbol de dispositivos, haga clic con el botón derecho en el objeto Application > Add Object > Cam
table...

En la caja de diálogo abierta, defina el nombre como es presentado en la Figura 5.13.

Haga clic en Add.

Figura 5.13: Crear tabla leva CAM.

Abra el objeto MyCam creado anteriormente.

El software Codesys tiene un editor gráfico leva CAM integrado que permite la creación y la edición rápida de
las tablas levas CAM.

Las tablas de levas CAM son definidas en este objeto. Usted puede alternar entre el editor gráfico (pestaña
cam) y el editor de tabla alternativo (pestaña cam table) en cualquier momento.
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Figura 5.14: Editor leva CAM.

5.5.2 Importar tabla leva CAM

Además de crear una tabla leva CAM, a través del editor, también es posible importar y exportar estas tablas.

Para importar o exportar una tabla leva CAM, abra el objeto MyCam.

Con el objeto abierto, es habilitada una nueva opción llamada Cam en el menú superior del software Codesys,
en esta pestaña se localizan las opciones para importar y exportar tablas leva CAM.

Figura 5.15: Importar/exportar tablas leva CAM.

Más informaciones sobre tablas leva CAM pueden ser encontradas directamente en el sitio de Codesys,
disponible en: https://help.codesys.com (Add-ons > CODESYS SoftMotion > Reference > User interfaz >
Objects > Object ’Cam Table’).
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5.5.3 Ejecutar tabla leva CAM

Para ejecutar una tabla leva CAM es necesario configurar los ejes que harán parte del movimiento.

Agregue dos ejes virtuales en esa aplicación (Axis_A y Axis_B), como es presentado en la subsección 5.3.

Configure la pestaña General de ambos ejes creados conforme la Figura 5.16.

Figura 5.16: Configuraciones tarea leva CAM.

Modifique la prioridad de la tarea MainTask a 1 y defínala con intervalo cíclico de 4ms.

La Figura 5.17 presenta las configuraciones de la tarea y los objetos ya agregados.

Figura 5.17: Configuraciones tarea leva CAM.

El programa estándar para ejecutar una tabla leva CAM es presentado en la Figura 5.18.

Abra las configuraciones del programa PLC_PRG(PRG).

Declare las instancias de los bloques de función y haga las conexiones de los bloques como es presentado
en la Figura 5.18
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Figura 5.18: Programa para ejecutar tablas leva CAM.

¡NOTA!
El Apéndice A presenta este mismo programa, utilizando el lenguaje ST.

A seguir, serán presentadas algunas informaciones referente a cada bloque del programa y sus conexiones.

Los bloques de función del tipo MC_Power son responsables por habilitar los ejes.

El bloque de funciónMC_CamTableSelect selecciona la tabla leva CAM a ser ejecutada. La entradaCamTable
debe referenciar la tabla leva CAM del árbol de dispositivos y la salida CamTableID debe estar conectada a la
entrada CamTableID del bloque de función MC_CamIn

El bloque de función MC_CamIn implementa la tabla de leva CAM seleccionada.

El bloque de función MC_MoveVelocity controla la velocidad del eje maestro.

Cree un objeto del tipo Vizualization.

Agregue y referencie el modelo de visualización del tipo VISU_NEW_MC_MoveVelocity al bloque de función
MC_MoveVelocity.

Agregue y referencie un modelo de visualización del tipo RotDrive para cada eje Axis_A y Axis_B.
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La Figura 5.19 muestra el objeto Visualization con los modelos agregados.

Figura 5.19: Visualización leva CAM.

Haga el download del programa en el PLC500MC.

En el modo de monitoreo Online, abra el objeto Visualization.

En el modelo de visualización del VISU_NEW_MC_MoveVelocity seleccione la velocidad de giro para el eje
maestro y haga clic en Execute.

El movimiento de los ejes puede ser observado por los modelos de visualización RotDrive.

Modifique la tabla leva CAM por el editor y realice algunas pruebas más.

Otros ejemplos de aplicación utilizando tablas leva CAM pueden ser encontradas directamente en el sitio de
Codesys, disponible en: https://help.codesys.com (Add-ons > CODESYS SoftMotion > Application Examples).
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5.6 INTERPRETAR Y EJECUTAR ARCHIVOS CNC

El PLC500MC tiene la capacidad de interpretación para Código-G (de acuerdo con la DIN 60025) utilizando el
editor CNC 3D presente en el software Codesys.

5.6.1 Alcance de los comandos (G-Code) soportados

Posicionamiento rápido (G0).

Interpolación lineal (G1), interpolación circular (G2/G3).

Temporización (G4).

Interpolación helicoidal (G5, G10).

Interpolación parabólica (G6), interpolación elíptica (G8, G9).

Selecciones de plan de interpolación para arcos circulares (G16 - G19).

Saltos condicionales (G20).

Grabación/incremento de variable IEC (G36, G37).

Compensación del radio de la herramienta (G40 - G42).

Redondeo y suavización de ángulos (G50, G51, G52).

Desplazamiento del sistema de coordinadas (G53 a G56).

Supresión de loop (G60, G61).

Sincronización de tiempo con interpolador (G75).

Coordinadas absolutas y relativas (G90, G91).

Configuración de posición (G92).

Coordinadas absolutas y relativas (G98, G99).

Funciones M (M), Taqués de camino (H).

Definición de velocidad y aceleración (F, E).

Dimensiones soportadas: X, Y, Z (ejes de interpolación primarios).

A, B, C (ejes de orientación).

P, Q, U, V, W (ejes adicionales).

5.6.2 Crear aplicación CNC

En esta subsección serán presentadas las configuraciones necesarias y los bloques de función utilizados para
ejecutar un camino CNC para una planta del tipo pórtico 2D.

Cree un proyecto nuevo en File > New Project. seleccione Standard Project, defina un directorio y el
nombre de la aplicación (Example_CNC). seleccione el dispositivo PLC500MC y el lenguaje de programación
Continuos Funcion Chart (CFC).

En el árbol de dispositivos, haga clic con el botón derecho en el objeto Application > Add Object > CNC
program...

En la caja de diálogo abierta, configúrela como es presentado en la Figura 5.20.

Haga clic en Add.
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Figura 5.20: Crear programa CNC.

Al agregar el objeto, observe en el árbol de dispositivos que además del programa CNC (MyCNC) es agregado
un objeto llamado CNC Settings. Las configuraciones de este objeto son válidas para todos los objetos CNC
de la aplicación. En las configuraciones del CNC Settings, pueden ser especificadas configuraciones para los
módulos de preprocesamiento de trayectoria, preinterpolación y editor de tablas CNC.

Las configuraciones de preprocesamiento disponibles son presentadas en la tabla 5.3.

Bloque de función Descripción
SMC_CheckVelocities Reduce la velocidad a cero en caso de que existan curvas cerradas.

SMC_AvoidLoop Desconsidera loop en el código.
SMC_ExtendedVelocityChecks Verifica la velocidad de los ejes adicionales.
SMC_LimitCircularVelocity Limita la velocidad en movimientos circulares.

SMC_ObjectSplitter Divide una curva en varios puntos.
SMC_RotateQueue2D Rota el camino 2D en el plan.
SMC_RoundPath Redondea cantos utilizando arcos circulares.

SMC_ScaleQueue3D Ajusta el factor de escala del camino.
SMC_SmoothAddAxes Suaviza movimientos de los ejes adicionales.
SMC_SmoothPath Suaviza las aristas de un determinado camino.
SMC_SmoothMerge Aproxima un número puntos por un polinomio.

SMC_ToolCorr | SMC_ToolRadiusCorr Corrige el radio de la herramienta.
SMC_TranslateQueue3D Desplaza el camino en X, Y y Z.
SMC_SmoothBSpline Suaviza segmentos de elementos G1 consecutivos con un B-Spline de quinto grado.

SMC_RecomputeABCSlopes Recalcula las inclinaciones de los ejes adicionales A,B,C, para ejecutar un movimiento suave.
SMC_ReduceVelEndAtCorner Reduce la velocidad final se hay una arista entre dos elementos de camino consecutivos.

Tabla 5.3: Descripción de los bloques de función de preprocesamiento.

Más informaciones sobre las configuraciones de preprocesamiento de trayectoria del objeto CNC Settings
pueden ser encontradas directamente en el sitio de Codesys, disponible en: https://help.codesys.com (Libraries
> SM3_CNC Library Documentation > SM_CNC_POUs > SoftMotion CNC > SoftMotion Function Blocks).
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Figura 5.21: Árbol de dispositivos CNC.

Abra las configuraciones del programa CNC (MyCNC).

En el editor CNC, escriba los comandos de la Figura 5.22.

Observe que al digitar los comandos, el camino CNC será presentado en el editor gráfico.

Figura 5.22: Programa CNC Básico.

Código G utilizado:
N000 G02 X20 Y12 I20 J-10 F1
N010 G01 X20 Y0
N020 G03 X0 Y12 I-20 J-10
N030 G01 X0 Y0

PLC500MC | 5-15



INFORMACIONES ADICIONALES SOFTMOTION

5.6.3 Importar archivos CNC

Además de crear un camino CNC, a través del editor, también es posible importar archivos del tipo DXF o ASCII
(.cnc, .gcode, .txt).

Para importar un archivo, abra el objeto CNC (MyCNC) en el árbol de dispositivos.

Con el objeto abierto, será habilitada una nueva opción llamadaCNC en el menú superior del software Codesys,
en esta pestaña están localizadas las opciones para importar archivos.

Figura 5.23: Importar/exportar caminos CNC.

Haga clic en Import from DXF File o Load Program from ASCII File y seleccione el archivo.

Con eso, el archivo será importado y podrá ser visualizado en el editor gráfico, como en la Figura 5.24.
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Figura 5.24: Camino CNC importado.

¡ATENCIÓN!
Las unidades utilizadas en el camino CNC son unidades de aplicación, realice una correcta
configuración de las escalas para los ejes.

Más informaciones sobre archivos CNC pueden ser encontradas directamente en el sitio de Codesys, disponible
en: https://help.codesys.com (Add-ons > CODESYS SoftMotion > Reference > User interfaz > Commands >
CNCCommand).

5.6.4 Ejecutar camino CNC

Para ejecutar un camino CNC es necesario configurar los ejes que harán parte del movimiento.

Agregue dos ejes virtuales en esa aplicación (Axis_A y Axis_B), como es presentado en la subsección 5.3.

Modifique la prioridad de la tarea MainTask a 1 y defínala con intervalo cíclico de 4ms.

La Figura 5.25 presenta las configuraciones de la tarea y los objetos ya agregados.
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Figura 5.25: Configuraciones tarea CNC.

El programa estándar para ejecutar un camino CNC controlando un sistema del tipo pórtico 2D es presentado
en la Figura 5.26.

En el árbol de dispositivos, abra el programa PLC_PRG(PRG).

Declare las instancias de los bloques de función y haga las conexiones de los bloques como es presentado
en la Figura 5.26
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Figura 5.26: Programa para ejecutar caminos CNC.

¡NOTA!
El Apéndice B presenta este mismo programa utilizando el lenguaje ST.

A seguir, serán presentadas algunas informaciones referente a cada bloque del programa y sus conexiones.

Los bloques de función del tipo MC_Power son responsables por habilitar los ejes.

El bloque de función SMC_Interpolator convierte un camino definido por objetos GEOINFO en puntos de
camino discretos. El bloque de función recibe la dirección del programa CNC en la entrada poqDataIn y el
tiempo de ciclo de la tarea IEC en que éste será ejecutado en la entrada dwIpoTime.

El bloque de función del tipo SMC_TRAFOF_Gantry2 corresponde a la transformación directa del sistema
Gantry2 y es necesario solamente para visualización.

El bloque de función del tipo SMC_TRAFO_Gantry2 corresponde a la transformación inversa del sistema
Gantry2 y es responsable por generar la referencia para cada eje en su salida.

El bloque de función del tipo SMC_ControlAxisByPosition controla la posición del eje conectado a la entrada
Axis. Como la aplicación no garantiza que las salidas del interpolador sean constantes (por ejemplo, el camino
termina en un punto diferente de donde empezó), es necesario activar la prevención de lagunas (bAvoidGaps,
fGapVelocity, fGapAcceleration, fGapDeceleration).

Cree un objeto del tipo Vizualization.

Agregue y referencie los modelos de visualización del tipo VISU_NEW_SMC_Interpolator y
SMC_VISU_Gantry2 a los bloques de función SMC_Interpolator y SMC_TRAFOF_Gantry2
respectivamente.

La Figura 5.27 muestra el objeto Visualization con los modelos agregados.
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Figura 5.27: Visualización CNC.

Haga el download del programa en el PLC500MC.

En el modo de monitoreo Online, abra el objeto Visualization.

El programa ejecuta el movimiento CNC así que la entrada Execute del interpolador sea accionada.

Tras la ejecución completa del programa, usted puede reiniciarlo por medio de un nuevo flanco de subida en
la entrada Execute del interpolador.

El movimiento puede ser observado por el modelo de visualización SMC_VISU_Gantry2.

Si lo desea, realice algunas pruebas más.

Ejemplos de aplicación utilizando caminos CNC pueden ser encontrados directamente en el sitio de Codesys,
disponible en: https://help.codesys.com (Add-ons > CODESYS SoftMotion > Application Examples).

5.6.5 Eje tangencial en caminos CNC

El PLC500MC posibilita aplicaciones que necesiten de un eje que tangencie el camino CNC durante el
movimiento. Este tipo de aplicación generalmente es utilizado en máquina de corte.

Cree una nueva aplicación como es presentado en la subsección 5.6.2.

Para ejecutar un camino CNC con eje tangencial es necesario configurar los ejes que harán parte del
movimiento.

Agregue dos ejes virtuales en esa aplicación (Axis_A y Axis_B), como es presentado en la subsección 5.3.

Agregue un tercer eje virtual (Axis_R), como es presentado en la subsección 5.3, sin embargo, en la pestaña
General, modifique el Axis type para módulo. Éste será el eje tangencial.

Modifique la prioridad de la tarea MainTask a 1 y defínala con intervalo cíclico de 4ms.
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El programa estándar para ejecutar un camino CNC controlando un sistema del tipo pórtico 2D con un eje
tangencial es presentado en la Figura 5.28.

En el árbol de dispositivos, abra el programa PLC_PRG(PRG).

Declare las instancias de los bloques de función y haga las conexiones de los bloques como es presentado
en la Figura 5.28.

Figura 5.28: Programa para ejecutar caminos CNC.

¡NOTA!
El apéndice C apresenta este mesmo programa utilizando a linguagem ST.

El bloque de función del tipo SMC_TRAFOF_GantryCutter2 corresponde a la transformación directa del
sistema GantryCutter2 y es necesario solamente para visualización.

El bloque de función del tipoSMC_TRAFO_GantryCutter2 corresponde a la transformación inversa del sistema
GantryCutter2 y es responsable por generar la referencia para cada eje en su salida.

¡NOTA!
La refencia del eje tangecial es calculada directamente por el bloque de función SMC_Interpolator
e interpretada por el bloque de función GantryCutter2, dispensando, de esta forma, la necesidad
de su referencia en el Código-G.

Cree un objeto del tipo Vizualization.

Agregue y referencie los modelos de visualización del tipo VISU_NEW_SMC_Interpolator y
SMC_VISU_GantryCuuter2 a los bloques de función SMC_Interpolator y SMC_TRAFOF_GantryCutter2
respectivamente.
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La Figura 5.29 muestra el objeto Visualization con los modelos agregados.

Figura 5.29: Visualización CNC.

Haga el download del programa en el PLC500MC.

En el modo de monitoreo Online, abra el objeto Visualization.

El programa ejecuta el movimiento CNC así que la entrada Execute del interpolador sea accionada.

Tras la ejecución completa del programa, usted puede reiniciarlo por medio de un nuevo flanco de subida en
la entrada Execute del interpolador.

El movimiento puede ser observado por el modelo de visualización SMC_VISU_GantryCutter2.

Si lo desea, realice algunas pruebas más.

Ejemplos de aplicación utilizando caminos CNC pueden ser encontrados directamente en el sitio de Codesys,
disponible en: https://help.codesys.com (Add-ons > CODESYS SoftMotion > Application Examples).

5.7 ALTERAR MODO DE CONTROL

Actualmente, el servoconvertidor SCA06 soporta dos tipos de modo de operación: modo de posición de
sincronización cíclica (csp) y modo de velocidad de sincronización cíclica (csv).

El bloque de función SMC_SetControllerMode, puede ser usado para alternar el modo de control del
SCA06_Motion.

Precondiciones:

1. El servoconvertidor debe soportar el modo de control deseado.

2. Los PDOs de transmisión y recepción necesarios deben ser mapeados.

3. El eje no debe estar en el estado errorstop, stop ni homing cuando el bloque de función
SMC_SetControllerMode sea ejecutado.

4. El SCA06_Motion solamente aceptará el nuevo modo de control cuando esté deshabilitado.

La Figura 5.30 presenta el modelo de visualización del bloque SMC_SetControllerMode.
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Figura 5.30: Modelo de visualización del bloque de función SMC_SetControllerMode.

Para cambiar el modo de control:

Agregue el bloque de función SMC_SetControllerMode en su aplicación.

Con la aplicación en modo Online. Asegúrese de que el eje esté deshabilitado (bloque de función
MC_Power).
En el bloque de función SMC_SetControllerMode seleccione el modo de control deseado.

Active la entrada del bloque de función bExecute. La salida bBusy del bloque de función quedará activa
durante 1000 ciclos.

Durante este período, habilite el eje.

Con eso, la salida bDone del bloque de función SMC_SetControllerMode quedará activa, indicando que el
modo de control fue modificado.
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6 CREAR Y CONFIGURAR RED CAN + SOFTMOTION

En esta sección son descritas las etapas necesarias para realizar el control de movimiento utilizando una
comunicación CAN entre el PLC500MC y el servoconvertidor SCA06, a través del software Codesys.

¡ATENCIÓN!
Para el control de movimiento utilizando la red CANopen, utilice un eje CiA402 genérico.

6.1 CONFIGURACIÓN DEL SERVOCONVERTIDOR SCA06 CAN

Conecte correctamente el cable de comunicación CAN y el servomotor al servoconvertidor SCA06.

Partiendo de los parámetros de estándar de fábrica del SCA06:

Altere el parámetro P0202 a 5 (control vía red CAN/EtherCAT).

Altere el parámetro P0385 al valor correspondiente al modelo de servomotor utilizado.

Altere el parámetro P0700 a 1 (configura el protocolo de comunicación CAN como siendo el CANopen.)

Altere el parámetro P0701 a 3 (configura la dirección del servo en la red CAN como 3).

Altere el parámetro P0702 a 0 (configura la tasa de comunicación de la interfaz CAN como 1Mbit/s).

Siga las recomendaciones descritas en el manual del servoconvertidor SCA06 para programar parámetros de
ajuste del equipo, relativos a la parametrización del motor, funciones deseadas para las señales de I/O, etc...

En caso de duda, consulte el Manual de Programación del servoconvertidor SCA06.

Reinicie el servoconvertidor.

Con eso, el servoconvertidor SCA06 estará pronto para ser accedido a través de la red CAN.

6.2 CREAR UN PROYECTO EN EL CODESYS

Cree un nuevo proyecto en File > NewProject. SeleccioneStandard Project, defina un directorio y el nombre
de la aplicación. Seleccione el Device PLC500MC y el lenguaje de programación deseado.

Agregue una nueva tarea responsable por el control de movimiento (Motion_Task) nesta aplicação. Aplique
as configurações da Figura 6.1.

Figura 6.1: Configuraciones de prioridad.
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6.2.1 Agregar CANopen Manager SoftMotion

Para agregar una nueva interfaz de comunicación CANopen Manager SoftMotion haga clic con el botón
derecho encima del objeto CAN en el árbol de dispositivos, haga clic en Add Device, en la caja de diálogo
seleccione la opción Append Device, y entonces Fieldbuses > CANopen >
CANopen_Manager_SoftMotion, haga clic en Add Device para agregar al árbol de dispositivos, conforme
la Figura 6.2.

Figura 6.2: Agregando CANopen Manager SoftMotion al árbol de dispositivos.

6.2.2 Agregar SCA06 como esclavo en la red CANopen

Para agregar el dispositivo SCA06 como esclavo de la red CANopen haga clic con el botón derecho en el
dispositivo CANopen Manager SoftMotion creado anteriormente y seleccione la opción Add Device.)

En la sección Action, de la caja de diálogo abierta, asegúrese de que la opción Append device esté
seleccionada. Busque el dispositivo SCA06 Fieldbuses > CANopen > CANopen Remote Devices > SCA06.

Haga clic en Add Device.

La Figura 6.3 presenta los pasos anteriores, directamente en el software Codesys.
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Figura 6.3: Agregando SCA06 como esclavo en la red CANopen.

¡NOTA!
En caso de que el servoconvertidor SCA06 no esté disponible, baje el archivo .EDS directamente
por el sitio de WEG, disponible en: https://www.weg.net/ y agréguelo al depósito de dispositivos
del Codesys (Tools > Device Repository... > Install...).

Para agregar un eje SoftMotion al SCA06, haga clic con el botón derecho en el dispositivo SCA06 agregado
anteriormente y seleccione la opción Add SoftMotion CiA402 Axis.

Figura 6.4: Agregando eje SoftMotion al SCA06.
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Cuando un eje SoftMotion sea agregado manualmente, será exhibida la caja de diálogo de la Figura 6.5.

Figura 6.5: Mensaje de alerta al agregar un eje SoftMotion manualmente.

Lea el mensaje y haga clic en OK.

Luego de estas configuraciones, el árbol de dispositivos deberá contener los íconos presentados en la
Figura 6.6.

Figura 6.6: Árbol de dispositivos para utilización del SoftMotion.

6.2.3 Configurar objeto CAN

Abra las configuraciones del dispositivo CAN, en la pestaña General, configure las opciones de la página
conforme la Figura 6.7.

Figura 6.7: Configuración estándar CAN.
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6.2.4 Configurar objeto CANopen Manager SoftMotion

Abra las configuraciones del objeto CANopen Manager SoftMotion, en la pestaña General, configure las
opciones de la página conforme la Figura 6.8.

Figura 6.8: Configuración estándar CANopen Manager SoftMotion.

También en las configuraciones del objeto CANopen Manager SoftMotion, en la pestaña CANopen I/O
Mapping, seleccione la tarea responsable por el movimiento (Task_Motion), como na Figura 6.9.

Figura 6.9: Configuración estándar CANopen Manager SoftMotion.

6.2.5 Configurar SCA06 como esclavo SoftMotion CAN

Abra las configuraciones del objeto SCA06, en la pestaña General, configure las opciones de la página
conforme la Figura 6.10.
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Figura 6.10: Configuración estándar SCA06 en la red CANopen SoftMotion.

También en las configuraciones del objeto SCA06, en la pestaña PDOs, seleccione solamente los PDOs de
la Figura 6.11.

Figura 6.11: Configuración estándar SCA06 en la red CANopen SoftMotion.

Modifique el Transmissiontype de los PDOs de transmisión y recepción para Cyclic - synchronous (Type
1-240) (para abrir las propiedades, haga clic dos veces en el PDO Communication).
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Figura 6.12: Configuración Transmissiontype de los PDOs.

6.2.6 Configurar SM_Drive_GenericDSP402

Aplique las mismas configuraciones de la Subsección 2.4.5.

6.3 MONITOREO

6.3.1 Estado de la comunicación CAN

El estado de la red CAN puede ser monitoreado en el modo Online del Codesys, indicando el estado de cada
una de las etapas de comunicación e informando el estado (Status). Al encontrar problemas de conexión, como
es mostrado en la Figura 6.13, verifique nuevamente si los cables están debidamente conectados y revise las
configuraciones hechas en la sección 6.

Figura 6.13: Indicación de error en la comunicación EtherCAT.

Cuando las configuraciones estén correctas y los dispositivos estén comunicando adecuadamente, todos los
ítems de la comunicación CAN estarán en verde, como es indicado en la Figura 6.14.
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Figura 6.14: Comunicación correctamente configurada y dispositivos comunicado.

6.3.2 Verificar la variación en la posición actual del servomotor

Luego de una correcta configuración de la red CAN y todavía en el modo Online abra las configuraciones del
SM_Drive_ETC_WEG_SCA.

Cuando el PLC esté en modo Online, en la pestaña General, será habilitado un campo para visualización del
eje, conforme la Figura 6.15.

Figura 6.15: Monitoreo online del servomotor.

En este campo es posible observar el estado del eje y de la comunicación, variables de posición, velocidad,
aceleración y torque, con sus referencias y valores actuales.

Mueva el eje del servomotor manualmente y observe el valor de la posición alterando en Position [u] - actual
value.
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6.4 COMISIONAMIENTO

Para probar las configuraciones aplique las mismas instrucciones presentadas en la Subsección 2.6.

Con las configuraciones aplicadas en esta sección, el eje ya podrá ser utilizado en las aplicaciones.
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A APLICACIÓN CAM

Este apéndice contiene la aplicación PLC_PRG, de la subsección 5.5, en ST.

PLC_PRG application:
PROGRAM PLC_PRG
VAR
Power_A : MC_Power;
Power_B : MC_Power;
CamTableSelect : MC_CamTableSelect;
CamIn : MC_CamIn;
MoveVelocity : MC_MoveVelocity;

END_VAR
Power_A(
Axis:= Axis_A,
Enable:= TRUE,
bRegulatorOn:= TRUE,
bDriveStart:= TRUE);

Power_B(
Axis:= Axis_B,
Enable:= TRUE,
bRegulatorOn:= TRUE,
bDriveStart:= TRUE);

CamTableSelect(
Master:= Axis_A,
Slave:= Axis_B,
CamTable:= MyCam,
Execute:= TRUE);

CamIn(
Master:= Axis_A,
Slave:= Axis_B,
Execute:= Power_A.bDriveStartRealState,
CamtableID:= CamTableSelect.CamTableID);

MoveVelocity(
Axis:= Axis_A,
Acceleration:= 10,
Deceleration:= 10,
Jerk:= 10);
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B APLICACIÓN CNC

Este apéndice contiene la aplicación MyMotion, de la sección 5.6, en ST.

MyMotion Application:
PROGRAM MyMotion
VAR
Power_A : MC_Power;
Power_B : MC_Power;
Interpolator : SMC_Interpolator;
Control_A : SMC_ControlAxisByPos;
Control_B : SMC_ControlAxisByPos;
TRAFO : SMC_TRAFO_Gantry2;
TRAFOF : SMC_TRAFOF_Gantry2;

END_VAR
Power_A(
Axis:= Axis_A,
Enable:= TRUE,
bRegulatorOn:= TRUE,
bDriveStart:= TRUE);

Power_B(
Axis:= Axis_B,
Enable:= TRUE,
bRegulatorOn:= TRUE,
bDriveStart:= TRUE);

TRAFOF(
DriveX:= Axis_A,
DriveY:= Axis_B,
minX:= 0,
maxX:= 20,
minY:= 0,
maxY:= 20);

Interpolator(
poqDataIn:= ADR(MyCNC),
bEmergency_Stop:= Control_B.bError OR Control_B.bStopIpo OR Control_A.bError OR Control_A.bStopIpo,
dwIpoTime:= 4000);

TRAFO(
pi:= Interpolator.piSetPosition);

Control_A(
Axis:= Axis_A,
iStatus:= Interpolator.iStatus,
bEnable:= Interpolator.bWorking,
bAvoidGaps:= TRUE,
fSetPosition:= TRAFO.dx,
fGapVelocity:= 50,
fGapAcceleration:= 50,
fGapDeceleration:= 50,
fGapJerk:= 50);

Control_B(
Axis:= Axis_B,
iStatus:= Interpolator.iStatus,
bEnable:= Interpolator.bWorking,
bAvoidGaps:= TRUE,
fSetPosition:= TRAFO.dy,
fGapVelocity:= 50,
fGapAcceleration:= 50,
fGapDeceleration:= 50,
fGapJerk:= 50);
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C APLICACIÓN CNC TANGENCIAL

Este apéndice contiene la aplicación MyMotion, de la sección 5.6.5, en ST.

MyMotion Application:
PROGRAM MyMotion
VAR
Power_A : MC_Power;
Power_B : MC_Power;
Power_R : MC_Power;
Interpolator : SMC_Interpolator;
Control_A : SMC_ControlAxisByPos;
Control_B : SMC_ControlAxisByPos;
Control_R : SMC_ControlAxisByPos;
TRAFO : SMC_TRAFO_GantryCutter2;
TRAFOF : SMC_TRAFOF_GantryCutter2;

END_VAR
Power_A(
Axis:= Axis_A,
Enable:= TRUE,
bRegulatorOn:= TRUE,
bDriveStart:= TRUE);

Power_B(
Axis:= Axis_B,
Enable:= TRUE,
bRegulatorOn:= TRUE,
bDriveStart:= TRUE);

Power_R(
Axis:= Axis_R,
Enable:= TRUE,
bRegulatorOn:= TRUE,
bDriveStart:= TRUE);

TRAFOF(
DriveX:= Axis_A,
DriveY:= Axis_B,
DriveR:= Axis_R,
minX:= 0,
maxX:= 20,
minY:= 0,
maxY:= 20);

Interpolator(
poqDataIn:= ADR(MyCNC),
bEmergency_Stop:= Control_B.bError OR Control_B.bStopIpo OR Control_A.bError OR Control_A.bStopIpo OR

Control_R.bError OR Control_R.bStopIpo,
dwIpoTime:= 4000);

TRAFO(
pi:= Interpolator.piSetPosition,
v:= Interpolator.vecActTangent );
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Control_A(
Axis:= Axis_A,
iStatus:= Interpolator.iStatus,
bEnable:= Interpolator.bWorking,
bAvoidGaps:= TRUE,
fSetPosition:= TRAFO.dx,
fGapVelocity:= 50,
fGapAcceleration:= 50,
fGapDeceleration:= 50,
fGapJerk:= 50);

Control_B(
Axis:= Axis_B,
iStatus:= Interpolator.iStatus,
bEnable:= Interpolator.bWorking,
bAvoidGaps:= TRUE,
fSetPosition:= TRAFO.dy,
fGapVelocity:= 50,
fGapAcceleration:= 50,
fGapDeceleration:= 50,
fGapJerk:= 50);

Control_R(
Axis:= Axis_R,
iStatus:= Interpolator.iStatus,
bEnable:= Interpolator.bWorking,
bAvoidGaps:= TRUE,
fSetPosition:= TRAFO.dr,
fGapVelocity:= 500,
fGapAcceleration:= 500,
fGapDeceleration:= 500,
fGapJerk:= 500);
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